
USVI Department of Education 1  1998, Sun Associates
info@sun-associates.com

Microsoft PowerPoint

The presentation application that is part of Microsoft Office is called PowerPoint.  PowerPoint is
virtually the world standard in presentation authoring tools.  It is commonly used in the business world
as well as in very many schools.  PowerPoint is sophisticated enough to be used to create marketing and
corporate information slide shows for multi-million-dollar enterprises, yet it is also so easy to use that
students in lower elementary grades can use it to make simple reports and presentations.  In between,
most users find that PowerPoint is a quick, relatively easy, and very attractive way to communicate
information using commonly available computer hardware.

One benefit that arises from PowerPoint’s integration into the Microsoft Office suite is that it is
relatively easy to import text, spreadsheets, graphics, tables, and clip art from other Office applications
into PowerPoint.  Further, once you learn how one Office application works – in terms of its menus,
Wizards, etc. – it is a simple matter to pick up the logic of another.  Thus, if you use Word or Excel, you
should be able to understand PowerPoint with little difficulty.

In this chapter of the Guidebook, we will briefly introduce you to PowerPoint’s menus and take you
through the creation of a short presentation.  We will also discuss some of the issues and concerns that
arise when you consider how PowerPoint is to be used in the classroom.

General  PowerPoint Tips

• Start simple.  Just as with Word and Excel, it is important to learn the program basics before
attempting to take full advantage of the program’s features.  This means that your first attempt to use
PowerPoint should not include self-timed slides, custom audio clips, or animated graphics.  Just
because you’ve seen someone else do something with the program, there is no reason to drive
yourself crazy trying to make your presentation “just like theirs.”  Eventually, you’ll learn the more
sophisticated features.  Your students will probably learn them first.

• Save often.  When you are learning a program, you will make mistakes.  Do not work for hours to
get something “just right” and then have everything lost when you mistakenly exit the program
without saving.  Save your work as you go along.

• Use the on-line help, the Wizards, and other documentation. A third-party step-by-step manual (such
as the …for Dummies  books) is very helpful.  These manuals are available in most bookstores and
all computer stores.

• Finally, our experience with PowerPoint is that the biggest problem most new users confront is that
they end up making their presentations so visually complex that no one would be able to even
comfortably look at their slides for very long…much less learn anything from the slides.  There are
many tools and options in PowerPoint.  You have the option of making some really ugly slides; and
that of course is not the point of the program.  So before you get started creating slides, consider the
following tips for creating appealing and concise presentations…
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Tips for Creating Appealing and Concise Presentations

• Outline your presentation.

Before you even start to use PowerPoint to create slides, first decide what you want your
presentation to say.  Outline your topics and key points just as you would any paper or presentation.
Then, start to make slides based on that outline.  If you want to be totally techno-savvy, you may
want to create an outline in Word and then import (or at least cut and paste) that outline into
PowerPoint.  Well, that’s optional…but the point is to outline one way or the other.

• Slides should convey key points – bullets – and ideas.  Keep the text to a minimum!

Your slides will be flashed on a screen for the viewer to read.  No one wants to read a paragraph of
text on a PowerPoint slide.  All that your viewer should have to read is a sentence or two or perhaps
a few words to get your meaning.  Further, you should be talking while most presentations are
running.  The slides are just illustrations to your discussion.

• Keep your slides visually simple.

Clip art, text, headings, and tables are too much for a single slide.  Once again, the viewer needs to
be able to grasp the meaning of your slide in seconds (and that’s about all the time they will spend on
the slide).  If you clutter the slide, your point will be masked.  Keep it simple.

• Use the default color schemes.

PowerPoint comes with default color schemes that have been chosen for visual clarity.  You have a
number of these defaults to choose from when creating your slides.  Use them. True, you could tell
the program to put pink text on a yellow background…but why?

• Keep animations to a minimum

Just because you can make every single line of text appear one…..line….at….a…..time….on your
slide, do you really want to?  More importantly, will your viewers rise up and strangle you after the
third slide that has text flying every which way onto the screen?  Once again, keep it simple.  Use
animations when you need to make a point.  Otherwise, just show your slide and move on.

• Keep it short

You cannot show 36 slides in 5 minutes.  If you try, you will run out of time and/or end up showing
slides at such a breakneck pace that your viewers will be left in the dust.  So you need to be concise
and quickly get to and make your points.  This is yet another reason for outlining your presentation
before you start creating slides.

Now, with all that said, let’s figure out how this program works!
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Opening PowerPoint

1. Open Microsoft PowerPoint by double clicking on its icon in the Microsoft Office folder or by
double clicking on its alias on your
desktop.

Alternatively, you can just double click on the icon for any PowerPoint presentation, and this will
start the PowerPoint program as well as opening the clicked upon presentation.

The icon for a PowerPoint presentation looks like this:

2. If you start PowerPoint from its program icon or alias (versus by clicking on an already created
presentation), you will get a screen which looks like this:
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The first couple of times you use the program, we suggest that you choose the option entitled
“Template.”  This is because our feeling is that “Blank presentation” gives you too little guidance (it
really is blank!) whereas “AutoContent wizard” guides you largely to create presentations that are
about business-related topics.

Choose Template by clicking on its radio button and then clicking OK.  This takes you to another
dialog box which looks like this:

Notice that there are a number of tabs on this box which will provide you with different presentation
templates.  Again, most of these designs are not particularly suitable for school use.  Therefore, we
suggest that you click on the Presentation Design tab and choose one of the designs.  As you click
on a design (just click ONCE), you will see it previewed in the window to its right. When you find
the one you like, click OK.

By the way, Presentation Designs control more than just the slide background.  They also determine
the font, type sizes, color schemes, and other formatting details.  You can over ride any of these
details later, but for now, accept what PowerPoint gives you.
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3. Once you have chosen your design (and the one we’ve chosen in this example is called
“Contemporary Portrait”), you get a screen which looks like this:

The thing you need to do now is to
choose one of these “Auto Layouts.”
Basically, these are layouts for slides.
The one highlighted by default is Title
Slide.  Choose this one as it will help
you layout the title slide (which
conventionally is the first slide of a
presentation).

4. The next screen you see looks like this:
This screen – and the menus at
its top and bottom -- is the one
you will work with while
working to create the
remainder of your presentation.

Notice that aside from the
standard set of Macintosh
Operating System pull-down
menus, you also have available
a number of icons or buttons.
The actual buttons you see are
determined by how Word has
been configured on the
specific computer you are
using.  Therefore, for the most
part in this guidebook, we will

focus on explaining the various actions you can make using menus.  In general, the menus are always
the same regardless of how your computer has been configured.
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PowerPoint’s Menus

By this time, you should have a very good idea as to what lies beneath the menus in a Microsoft Office
application.  But just in case you are reading this chapter first (i.e., before the ones on Word or Excel),
we will overview the main features of the PowerPoint menus.

Also, remember that as with Word and Excel, the menus are just one way to execute functions in the
program.  Many users choose to use the toolbars and buttons to control PowerPoint (but as we have
noted, often you will find that someone before you has changed the default buttons and/or
toolbars…therefore we will discuss the menu commands which are much less likely to have been
changed by a “helpful” student or fellow teacher).

File

Nothing particularly novel here.  These are the same options traditionally
available in the File menu.  The major differences between PowerPoint
and other Microsoft Office applications in this area comes in the Print
command.  We will discuss this later in this chapter when doing the step-
by-step.

Edit

Once again, this too is a pretty standard Edit menu for an Office application.
Two commands which bear mention here are:

Duplicate...................This will duplicate the current slide or whatever text,
graphic, etc. you have selected.

Delete Slide ...............This does what you expect.  Use it with caution.
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View

Key to working with PowerPoint is mastery of the various “views” of your slides.  These views are
controlled using menu options in the View menu – or by the small buttons
at the lower left corner of the PowerPoint screen.

Views are also available in other Office applications, but in PowerPoint,
they are critical to properly editing/creating slides and to showing your final
product as a complete “slideshow.”

Slide............... The Slide view allows you to view just one slide on your
screen, much like a word processing document.  This is the best view with
which to edit slide content.

Outline .......... The Outline view focuses on slide text.  It shows a small
version of the slide (known as a thumbnail) which cannot be edited, but
allows you full control over text.

Slide Sorter The Slide Sorter view is very useful for two things…1)
seeing the order of your slides, and 2) adjusting the animation features –
transitions and builds – on your slides.  In slide sorter view, you can insert

new slides, drag slides into different orders, and delete slides.  While you cannot edit the content of any
slide (other than its build animation), you can double click on a slide image within the slide sorter view
and be taken into Slide view where you can edit.

Notes Page .... This view allows you to add notes (sometimes called “speakers notes”) to a slide and also
to edit the slide content.  This is sort of an expanded Slide view.  The notes will not be
visible when you show your slide show, but they can be printed.

Slide Show .... This is the view where you see the ultimate product of your work.  This “view” removes
all desktop, menu, PowerPoint, and Finder features from your screen and fills the screen
with your PowerPoint slide.  You move through the slides by clicking with your mouse or
hitting the Return key on your keyboard.  It is not possible to edit slides in Slide Show
view.

Master........... This takes you to another menu which allows you to edit the “Master” slide, handout
master, or notes master.  This is a way of changing the background, format, and other
features of all of the slides in your presentation (this will not effect PowerPoint’s
program defaults, just the slides in the current presentation).

The other options in the View menu control various ways that the PowerPoint program functions and
appears.  These options are very similar to other Office programs (i.e., toolbars, rulers, image size, etc.).
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Insert

New Slide ..................This is how you add slides to your presentation.
While starting the program provides you with the first slide (the title slide,
assuming you picked that format), you need to use this menu option to
keep adding slides.

Slides from File ........You can import slides from other PowerPoint
presentations into your current presentation.

Slides from Outline..Likewise, you can bring in slide content (for entire
slides) from an outline that you have created using Word or another word
processor.

Picture Use this menu option to insert Clip Art, photographs, and other images into your slide.
When you choose this option, you will be taken to another menu which will ask you what type of
graphic (picture) you want to insert and where the inserted file currently resides (on a floppy, on the
desktop, in the Clip Art folder, etc.).

Movies and Sounds.. This option allows you to insert Quicktime movies and audio files into you slides.
With these, you can have a movie or sound play while your slide is showing.  For more information on
Quicktime movies and audio files – for use in all
applications, not just PowerPoint – you should consult program documentation, an after-market book, or
your technology coordinator.

Chart. ........... Allows you to insert a chart (e.g., an organization chart) that has been created using the
Microsoft Chart application.  This application starts when you choose the Chart menu option.  The
Chart application is not a particularly full-featured program, and if possible you would be better off
using Excel to create a chart (graph) and then cutting and pasting that into your slide.

Object ........... In most cases, objects are the same as pictures, movies, sounds, and charts.  It is possible
though to insert links to other programs/applications…and that is what this menu option enables.  Not
too useful to the novice user.

Hyperlink ..... If you have an Internet connection and web browser (e.g., Netscape) installed on your
computer – and the computer where you intend to show your presentation – you can insert WWW
addresses on your slides.  When you do this, you can click on these addresses/hyperlinks during a slide
show and automatically “launch” your browser and go to the address.  The Hyperlink menu option
enables this sort of insertion.
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Format

The Format menu contains a number of commands that (go figure…)
control the format of your slide.  Here, you can choose fonts, do universal
replacement of fonts (Replace Fonts), change the Layout of your slide
(e.g., changing from a Title layout to a Bulleted List layout), change the
color scheme, design (e.g., Contemporary Portrait, etc.), and background.
Most of these formatting elements can be applied to just a single slide or to
all of the slides in your presentation.

Tools

The Tools menu contains the expected Spelling Checker, macro recorder, and
program default setting (Preferences) and customizing menus.  Meeting
Minder is a small notepad application that allows you to take notes during a
meeting or presentation.  This really has nothing to do with the PowerPoint
application, but some users may find it useful.

Slide Show

The options on the Slide Show menu allow you to control how your
presentation appears when you have finished it and are viewing it in Slide
Show “view.”  As noted in the View menu discussion, Slide Show view is
how you actually present your show.  The most commonly used options on
this menu are discussed below.

By the way, the term “animation” used in the Office 97/98 version of
PowerPoint is what was called Build in previous versions.  Pretty much the
same thing, but with a different name.
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View Show.... This option switched you into Slide Show view and starts your show.

Preset AnimationThis option allows you to choose from a number of preset (i.e., determined by the
program’s authors) slide animations.   Choosing options here will allow you to have the text and
graphics on your slide appear (build) in various ways upon the click of your mouse.

Custom Animation .............. Using options on this menu, you can achieve a much greater degree of
control over slide animation (build) than in the Preset Animation menu.

Slide Transition.................... The options on this menu control how PowerPoint closes the current slide
(in a slide show) and “transitions” to the next slide.  You have many options here…fades, boxing, etc.

Once again, remember the tips for clear and concise presentations discussed at the start of this chapter.
You are well advised to keep it simple when choosing slide animations and transitions.  No one wants to
sit through a presentation that has been cluttered by unnecessary animations.  Not every slide needs to be
animated!

Window

Nothing unusual here.  This is just the standard set of commands for creating new
windows and arranging open PowerPoint windows if you have more that one
presentation open at a time.

Help

And finally, this is the standard Office/Macintosh help menu.

As you might expect, PowerPoint allows you access to the same
little help dude is still available in
PowerPoint. If you need to summon him
(or her), just click on the Microsoft
PowerPoint Help menu option.
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Creating a Presentation

Let’s create a simple PowerPoint presentation.  In this example, we’re going to assume that the main
point of the presentation is to describe a plan to raise funds for a class trip to Puerto Rico (we’re going
to El Morro).  We already know that we have about 5 minutes to make our presentation before the
school PTO, so we’d better be short, concise, and to the point.  Ok, let’s go…

• First, we need to outline.  You could create an outline in PowerPoint itself, but for the sake of
simplicity, let’s just sketch out an outline “on paper.”

• Introduction – Fundraising for the Puerto Rico trip
• Who’s going?
• Anticipated costs
• Fund raising strategies
• Summary
• Issues
• Timeline

Given  the amount of time we will have to deliver our presentation (5 minutes), six or seven slides is
about all we will want.  Remember, the goal is to have slides which form talking points for our
presentation…not slides that are to be “read” as text by the viewers.

1. Next, open PowerPoint and choose the Presentation Template option from the first dialog box.
When asked to choose a design, choose the one called “Sparkle.”  That’s the one that looks like this.

Then, when asked to choose an to Layout (for the first slide), choose the
default “Title Slide.”  This is the one which looks like this:
Now, you’re ready to move on to the next step, the one
where you start to add content to your presentation.

2. Let’s put a title on the title slide, some graphics, and our name.  Here’s how to do that.

Notice that you are in Slide Layout view.  This means that you can edit all of the content of the
slide.  You can add text by typing where prompted to on the slide.  Graphics can be added by using
the Insert menu and choosing
Picture.



USVI Department of Education 12  1998, Sun Associates
info@sun-associates.com

When all done with our title slide, it might look something like this:

3. You may find it useful to switch to Outline view (using either the command in the View menu
or by clicking on the little button at the bottom left corner of your PowerPoint window) and to
simply type in your slide show’s text…then later, you can go back and add images and clean
things up.

If you do this, you will be in a screen which looks something like this while creating your slides
in the Outline view:

Note that the graphic can be
placed anywhere  on the
slide!

Use these
“Promote” and
“Demote”
arrow buttons
to change the
text on a slide
from title to list
text (or vice
versa)This is a little

preview of what
your slide will look
like (this can’t be
edited)These buttons change you from

outline to layout (etc.) view
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4. Once you are finished creating your slide content, it is useful to look at all of your slides in
Slide Sorter view.  This way, you can see small versions of all slides, edit
transitions/animations, and by double-clicking on any small image, you can go into Slide
Layout view and edit a slide (add graphics, change text, etc.).

Also, remember to save your presentation!

Slide Sorter view looks like this:

These pull-down menus show the
transition and animation effects
for the current slide (the one with
the box around it.  Also, the little
icons below each slide image
indicate whether there is a
transition or animation applied to
the slide.

When a slide has a
black box around it,
you can double-click
and edit it…and you
can see its transitions
and animations at the
top of the Slide Sorter
screen.
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5. That’s about it!  When you are satisfied with your work, save one last time.

6. When you want to show your presentation, simply open the saved file (by double-clicking on its
icon) and choose View Show from the Slide Show menu.
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Displaying a Presentation

Unless you are satisfied with having your entire audience cluster around your computer monitor, you
will need to figure out some way to display your presentation for everyone to see.  Generally, this is
done by using some sort of device to take your computer’s video output and display it on a TV, video
projector, or LCD panel.  The chart below summarizes some of these options.

Device Approximate Cost Advantages Disadvantages

Existing computer
monitor

$0 (you already have one) • No additional cost
• No additional set-up

time/skills required

• Too small for more
than a few people to
view at once

• Unless you have a
Powerbook, the
monitor is probably
not portable

LCD Panel $2,500 to $4,000 (includes
about $500 for a proper
overhead projector)

• Somewhat portable
• Creates a large display
• Can generally be

interchanged easily
between Mac and PC

• Won’t work with
most school overhead
projectors (they’re not
bright enough)

• Won’t work unless the
room is very dark

• Easy to break and
impossible to repair

• Very costly
Video Projector $3,500 or more • Single device, no

overhead required
• Can be used in

virtually normal room
light

• Very clear and sharp
image

• Easy to set up
• Very portable
• Will work with Mac,

PC, laser disc player,
VCR

• Most also have
speakers for sound

• Very costly

Scan Converter $150 to $500 • Single device, no
overhead required

• Connects to any
existing TV

• Very cost effective

• Image not as clear as
Video Projector
(especially with the
inexpensive ones)

• Not all are cross-
platform (i.e., may
need one for the Mac
and another for PCs)



USVI Department of Education 16  1998, Sun Associates
info@sun-associates.com

Our recommendation?  Go with the scan converter.  The video projector is technically the best choice,
but until the cost comes down on these units, it is unlikely that your school could afford to buy even one,
much less two or three to circulate around the school.  The LCD panel is a good concept, but in practice
is worthless in most schools.  They are fragile and difficult to set up and most classrooms cannot be
made dark enough to allow anyone to see the projected image.  If you have the money to buy an LCD
panel, you ought to spend it on a video projector instead.

The scan converter is inexpensive and works with all of those big TVs (19” or larger) you already have!
You do not need to buy a new or “special” TV.  If the TV works with a VCR (i.e., you can plug the
VCR into the TV and the picture is good enough for a class or large group to view), then it will work
with the scan converter.  You can buy several converters and allow teachers to check them out with the
TVs for when they think they will need them.   True, the image quality is not up to monitor or  video
projector standards, but they accomplish the primary task of allowing an entire class to see the output of
a single computer.

Some brand names for scan converters are TV View and AverKey.  You can generally order these via
mail order catalog (Mac Zone, MacWarehouse, Mac/PC Connection, etc.) or ask your technology
coordinator for assistance.



USVI Department of Education 17  1998, Sun Associates
info@sun-associates.com

Acknowledgements
This Guidebook has been created as a resource for teachers, and especially those in the US Virgin
Islands who attended the August, 1998 Summer Technology Institute.  The reference materials and step-
by-step guides are intended to serve as long-term backups to the hands on sessions and exploration that
occurred in the Institute.

The August 1998 USVI Summer Technology Institute was collaboratively planned and facilitated by the
USVI Department of Education and Learning Innovations for the Southeast and Islands Regional
Technology in Education Consortium (SEIR*TEC).  Learning Innovations, a division of WestEd, is a
partner in SEIR*TEC, funded by the U.S. Department of Education to support the integration of
technology in education. This Guidebook document is based on work sponsored wholly or in part by the
Office of Educational Research and Improvement (OERI), under grant number R302A50010, CFDA
84.302A.  Its contents do not necessarily reflect the views of OERI, the US Education Department, or
any other agency of the United States government.

Sun Associates, a consultant to Learning Innovations, was responsible for authoring the content of this
Guidebook.  Our work was driven and informed by experience working with hundreds of schools and
teachers across the U.S. and at all levels of technical ability.  First and foremost, we would like to thank
those teachers for sharing their skills, concerns, and (all too often) frustrations related to the use of
instructional technology.  We would also like to thank the educators and staff developers – many of
them anonymous on the web or thorough un-credited workshop handouts – who have produced training
materials similar to this Guidebook.  These materials have provided conceptual guidance and have
served as models for what to include and exclude from our work.  In the Guidebook’s general
bibliography, the reader will find several listings for other basic computer applications guides and
manuals which will no doubt fill in some of the gaps remaining in our work.


